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 Lab 3: Timber Supply Analysis 

Introduction 
In this lab students will produce the data files needed to use FSSIM to undertake 
a timber supply analysis and recommend an allowable annual cut for a study 
forest. 

Students will be required to produce a report that describes the inventory, 
documents the base case forecast and sensitivity analyses, and provides a 
rationale for the allowable annual cut recommendation. It is recommended that 
students work in pairs to complete the lab and assignment. Reports may be 
submitted individually or by both students.  

Learning Objectives 
Lab 3 builds on the skills you developed in Labs 1 and 2. At the conclusion of this 
lab it is expected that students will understand: 

• how to aggregate forest inventory into analysis units 

• how to specify forest cover constraints in FSSIM 

• how to prepare the data input files for FSSIM 

• how to find a base case harvest forecast 

• how to undertake sensitivity analysis to identify risks in data and 
assumptions associated with the base case 

• how forest management objectives and regimes affect timber supply. 
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Foreword 
Timber supply analysis is a sequential process, which means that many of the 
early decisions you make in building the FSSIM databases will affect the 
opportunities and outcomes of your later work. Think things through before you 
start, and if you need clarification, ask for help. [No one said it would be easy, 
but it’s probably not as hard as it looks.] 

You have a little more than three days to complete your analysis of timber 
supply for the study forest. Time will be spent roughly as follows: 

• Thursday afternoon:  

– plan your analysis—specify management objectives, define indicators 
and criteria 

– get familiar with the forest inventory  

– determine site class boundaries, and define analysis units based on 
leading species and site class; think about management regimes for each 
analysis unit 

– using software provided, specify site class boundaries, classify the 
inventory into analysis units, and generate the FSSIM class file (class.dat). 

• Friday:  

– project yield tables representing growth of existing and regenerated 
stands for each analysis unit, and create FSSIM yield files (vols.dat) 

– specify regeneration pathways for each analysis unit (regen.dat) 

– define FSSIM groups (group.dat) and specify cover constraints for each 
zone or group (axs.dat) 

– create remaining FSSIM input files (oaf.dat, landoaf.dat, roads.dat, 
config.dat, param.dat). 

• Saturday: 

– develop base case harvest forecast (targets.dat) 

– undertake sensitivity analyses 

• Monday: 

– continue sensitivity analyses 

– develop a silviculture strategy for the management unit 

– recommend an allowable annual cut 

– write and submit report 

Remember, you can’t hurt the computer, so don’t be afraid to experiment. On the 
other hand, you have a limited amount of time, so use it wisely. 

Good luck! 
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Lab 3 Overview  
Lab 1 introduced you to forest estate modeling. Lab 2 introduced you to the heart 
of timber supply analysis—the process of establishing a base case harvest flow 
forecast. In Lab 3 you will process inventory files and produce the FSSIM input 
data files needed to undertake a timber supply analysis and recommend an 
allowable annual cut for a study forest.   

Lab 3 in your FMIBC module 5 folder contains an inventory file (inventory.txt) 
that you will process with a program developed for this lab. This program 
(MODULE 5 INPUT DATA PROGRAM), will allow you to: 

• browse through the inventory file (inventory.txt),  

• define site class boundaries and run a program (SITECLASS) that assigns a 
site class value to each record in the inventory and generates an updated 
inventory file (Updated_Inventory.txt).  

• define analysis units (in a file called AUnit.txt). 

• run a program (CLASS) that will aggregate records in the inventory file by 
analysis unit, create the FSSIM class.dat file, and generate another file 
containing information needed for projecting yield tables (GYParameters.txt). 

You will use these programs and files to create the FSSIM input files needed to 
complete your timber supply analysis.   

In this lab you will need to create the following FSSIM files: 

class.dat vols.dat group.dat targets.dat 

landoaf.dat regen.dat axs.dat param.dat 

roads.dat oaf.dat reports.dat config.dat 

 

Copy your Lab 2 versions of the .dat files to use as templates for these files in 
Lab 3. First, in your Lab 3 folder, create another folder called Base Case. Put a 
copy of each Lab 2 .dat file (except the class.dat files) in the Base Case folder. 
Change the file extension from .dat to .tmp. Later, when you have modified this 
file by adding the new information needed for Lab 3, change the extension back 
to .dat.  

Some of these input files will require no change (e.g., param.dat, config.dat). The 
most effort will be required to create the vols.dat, regen.dat, group.dat, and axs.dat 
files. 
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Lab 3 Assignment 
You must complete the 14 steps in this lab. We strongly suggest that you 
document each step carefully as you work your way through the assignment. 
This will make it much easier to complete the report (Step 14).  

Read through the full lab and make sure you understand what is required in 
each step before you begin.  

STEP 1 Introduction to the INPUT DATA PROGRAM 

The INPUT DATA PROGRAM is used to build an FSSIM class.dat file. Click on 
the start button, and under Programs, choose FMIBC, and the FMIBC Module 5 
Input Data Program (IDP). This program enables you to: 

• run two executable programs (CLASS, SITECLASS) by clicking on the 
toolbar buttons that appear when needed [Don’t run these yet.]  

• browse and edit the inventory and other files. 
 

STEP 2 Familiarize yourself with the forest inventory 

In this lab you will be working with a forest inventory derived from the TSR data 
set for the Fraser TSA. The FSSIM class file (class.dat) is generated by running the 
program called CLASS, which processes the inventory.txt file.  

In the INPUT DATA PROGRAM, open the inventory.txt file and view the file by 
using the vertical and horizontal scroll bars to view rows and columns that aren’t 
visible in the window. [Do not edit this file.] Each record contains information 
describing species composition, site index, age, crown closure, operability and 
area. There are blank fields in which analysis unit numbers and site class labels 
will be inserted by the program. 



 
 Forest Management Institute of British Columbia Spring 2002 

Lab 3: Timber Supply Analysis 
 
 
 
 

Lab3 Apr2002.doc  2001-05-23 12:16 PM 5 

STEP 3 Specify site class boundaries for the inventory 

Click on the SITECLASS toolbar button, which will open a form showing fields 
in which you must specify the site index class boundaries (minimum and 
maximum values) used to assign the site productivity classes in the inventory 
file. Site indexes that are between the lower boundary and the upper boundary 
(inclusive) will be in the specified site class.  

Use the pull-down lists to choose site index boundary values. When you are 
finished, click on the “OK” button, which starts the SITECLASS program. 
SITECLASS assigns a site class to each record in the inventory.txt file, and creates 
two new files: Updated_Inventory.txt and AUnit.txt. 

STEP 4 Define and assign analysis units 

Define analysis units 

Before you can make decisions on how to aggregate the inventory into analysis 
units (AUs), you need to be familiar with the species composition and site 
productivity of the forest. This will be easier to do if you import the 
Updated_Inventory.txt file information into an Excel spreadsheet and create a 
pivot table, as follows:  

1 Open Excel. Under the File menu, choose Open, find the FMIBC module 5 
folder [c:/windows/desktop/FMIBC module 5]. Then open the Lab 
3/Inventory directory and choose Updated_Inventory.txt.  

2 Before you can work with the inventory information you must separate the 
text into columns. There are approximately 26 000 inventory records in the 
file. Click on cell A1. Then, holding down the <Shift> key, press <End> and 
then <down-arrow>, which selects the entire column with data in it. Choose 
Data/Text to Columns and use the Excel “wizard” that starts up to convert 
the text file to columns in the spreadsheet. 

3 To create a pivot table, first select the entire table of numbers. (Place the 
cursor in cell A1, and holding down the shift key, use the right arrow key to 
select the first row of numbers, then touch the end key and the arrow down 
key.) Under the Data menu, select Pivot Table and Pivot Chart Report. Click 
Next two times, choose New Worksheet, and then click Finish.  
 
Now, design your pivot table. Drag species1 and species2 to the row section 
of the table, site class to the column section, and area to the data section 
(where it will show as “sum of area”). All going well, you will have created a 
table that summarizes the inventory records by leading and secondary 
species and site class. This table will be useful in making decisions about 
analysis units. [Save this worksheet as an Excel file (updated_inventory.xls) 
and print a copy.] 

When thinking about how to define AUs, remember that you will have to create 
two volume tables for each AU. Not all species are included explicitly in TIPSY—
some will be used as surrogates for others. Consider the amount of area in each 
species combination and site class. 
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Assign analysis units 

Return to the INPUT DATA PROGRAM, and open the file AUnit.txt. It lists 
every combination of leading and secondary species, site class, and class type 
(operability) for the inventory. Depending on the site class boundaries you chose, 
there may be a little more than 200 records in this file.  

Once you have decided on the composition of your AUs (species composition 
and site class) assign an AU number in the first column of the AUnit.txt file. Save 
the file when done.  

STEP 5 Use CLASS to process inventory files into analysis units 

Run the program CLASS by clicking on the button labeled <CLASS>. This 
program creates three files: Inventory_Summary.txt, GYParameters.txt, and 
class.dat.  

Open and inspect the file called Inventory_Summary.txt. Each record in this file is 
an aggregate of inventory records (from Updated_Inventory.txt) having the same 
combination of zone, species 1, species 2, site class and class type (OPER). That is, 
the file will be an inventory file with area aggregated according to the analysis 
units defined in AUnit.txt. Check to verify that the classes have been aggregated 
as you expected. If not, check the AUnit.txt and Updated_Inventory.txt files to 
confirm that they are properly specified.  

The file called GYParameters.txt contains weighted average site index, crown 
closure, and species composition values that will be needed to project yield 
curves for each analysis unit. 

The third file created by CLASS, called class.dat, is the inventory file used by 
FSSIM. 

STEP 6 Create volume tables for each analysis unit  

Define a management regime for each AU (how it will be regenerated, initial 
density, will it be thinned, etc.). Specify no regeneration delay in TIPSY. Create 
volume tables representing the development of natural stands using VDYP, and 
the development of managed stands using TIPSY. The parameters needed to run 
these yield models can be found in the file called GYParameters.txt. Use the 
weighted SI for the AU and enter the % of each species (must total 100%).  

Note that any yield model or yield table can be used to develop the volume 
tables needed to run FSSIM. In this course we use VDYP and TIPSY because they 
are convenient and widely accepted for use in BC. 

Creating the vols.dat file is onerous, especially if you have specified a large 
number of AUs. You can take different approaches to creating this file. One is to 
print the VDYP or TIPSY volume tables that you created, and then type the age 
and volume information directly into the vols.dat file. A second approach is to 
copy the TIPSY and VDYP output, paste it into Excel, reformat the information, 
and then save it as a space-delimited text file (.prn).  
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These approaches take about the same amount of time.  

If you choose the second approach, follow these steps: 

1 Copy the VDYP or TIPSY volume table into a new Excel workbook. It will 
copy into the first column of the spreadsheet. Select the column of pasted 
information. Under the Data menu, select Text to Columns, and follow the 
Wizard through the default steps to separate the information into columns.  
You need only two columns of data for your vols.dat file—age, and volume. 
Delete the columns you do not need. Somewhere in your notes, record the 
CMAI for the table. 

2 Insert two rows above the table (as shown below), and insert a Table 
identifier (Table:   <table #>), and column headers (Age, Volume).  There 
should be no space between the header rows and the first row of data.  

  Table:   1 
   Age     Volume  
    10       0   
    20      20 
    etc….     

3  Following this procedure, create all the volume tables needed, adding each 
new table below the one just created. Leave one blank row between the 
bottom of one table and the top of the next. When you have created all the 
volume tables needed, with header rows for each table, centre the columns 
and adjust the column widths so that there is some space on each side of the 
entry in each cell. Doing this will ensure that the text file (vols.dat) is properly 
spaced.  

 Save the file as an Excel file with name vols.xls  to archive it in Excel in case 
you have to come back to modify it.  

 Next, save the file again, this time in the format needed for FSSIM. Choose 
Save As… under the File menu. Specify the File name as vols.dat and the file 
type as “Formatted Text (Space delimited)(*.prn)”. Finally, in Windows 
Explorer change the name of the file to vols.dat. 

STEP 7 Define regeneration pathways 

The regen.dat file charts the post-harvest regeneration path for each analysis unit. 
Open the regen.tmp file and type in the regeneration analysis unit (RegenAU) 
assigned to each AU after harvesting. Type the associated regeneration delay as 
the negative regeneration age in the RegenAge column. [Which is why we 
warned you to specify no regeneration delay in TIPSY.] Note that you can 
specify portions of an analysis unit to go to different RegenAUs under the PC 
[percent] column. You must enter the pathway for each analysis unit in each of 
the seven zones in the TSA. [Poor people who have very many AUs!!]. When you 
have finished, save the file as regen.dat. 
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STEP 8 Define minimum harvestable age 

Choose the criteria by which you will define minimum harvestable age: 
culmination of MAI, age when some minimum average diameter is reached, age 
when some minimum volume is reached, or some other criterion. [Write it 
down.] Apply this criterion consistently when setting a MHA for each analysis 
unit in the oaf.tmp file. Specify OAF1 as 1.0 and OAF2 as 0.0 for each AU. When 
complete, save this file as oaf.dat.  

STEP 9 Define management objectives and requirements, and construct FSSIM 
data files needed to represent these objectives and requirements 

One way to represent special management emphasis is by applying forest cover 
constraints. Applying a cover constraint requires first identifying the unit to 
which the constraint will be applied, and then constructing a constraint in the 
axs.dat file.  

In your data set, Fraser TSA landscape units have been aggregated into seven 
FSSIM zones. Management emphasis areas will be represented in the model as 
groups composed of these zones (Table 1). Cover constraints representing 
management emphasis for non-timber values will be assigned to these groups. 
The parameters for each management emphasis are shown in Tables 2-4.  

Open the file called group.tmp, and create a group that will represent each 
management emphasis area. When done, save this file as group.dat.  

Next, in file axs.tmp, create a forest cover constraint representing each 
management emphasis (Tables 2 to 4) in the appropriate groups. When done, 
save this file as axs.dat. 

 

Table 1 Zones in each management emphasis area. 

Management Emphasis Area Zone 

Retention VQO 1 

Partial Modification VQO 2, 3, 6 

IRM 4, 5, 7 

Spotted Owl SRMZ 1, 2 

Biodiversity—NDT2 1, 4, 5, 6, 7 

Biodiversity—NDT3 2, 3 

 

Table 2 Visual quality objectives (VQO), by zone. 

Zone 
Area 
(ha) VQ0 

Green-up age 
(year) 

Maximum 
Disturbed 
Area (%) 

1 16921 R 16 3 

2 51437 PM 16 15 
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3 58322 PM 16 15 

4 65634 IRM 12 30 

5 99814 IRM 12 30 

6 90534 PM 16 15 

7 114641 IRM 12 30 

 

Table 3 Natural Disturbance Type (NDT) and old-growth constraints, by zone. 

Zone NDT Old-growth age Old-growth % requirement, by decade 
     (years) 1-70 71-140 141+ 
1 NDT2 250 7 8 9 

2 NDT3 140 11 13 15 

3 NDT3 140 11 13 15 

4 NDT2 250 7 8 9 

5 NDT2 250 7 8 9 

6 NDT2 250 7 8 9 

7 NDT2 250 7 8 9 

 

Table 4 Spotted owl management emphasis and cover constraints, by zone. 

Zone 
Age limit 
(years) 

Minimum area 
(%) 

1 100 67 

2 100 67 

 

Create groups for reporting 

You may also wish to create groups that identify specific components of the 
landbase (e.g., FSSIM zone) or inventory (e.g., a particular analysis unit or a 
range of age classes) so you can report on their condition (e.g., you might want to 
view the seral stage distribution for the whole forest or within each zone). Create 
a group in group.dat for each such component.  

Each group must be added to the reports.dat file if you want the results to be 
reported in the FSSIM tabular reports and the group to be visible in the FSSIM 
Graph Results window.  

STEP 10 Specify remaining FSSIM input files 

Before running FSSIM, you must also create param.dat, config.dat, landoaf.dat and 
roads.dat files. Open the .tmp versions of these files and complete as necessary, 
then save each file as a .dat file. 

In the roads.dat file, specify a deduction of 1% to be applied to stands older than 
120 years. 
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STEP 11 Use FSSIM to produce a base case harvest forecast 

The base case is the best harvest forecast you can produce, based on current 
management practices. It should ensure the long-term productivity of forest 
lands, while avoiding excessive changes from decade to decade and future 
shortfalls. The base case provides a basis for comparison when assessing 
uncertainty about, or changes to, data and assumptions.  

The base case harvest forecast you developed in Lab 2 was for a very simple 
representation of this forest (e.g., 5 analysis units, no forest cover constraints). To 
develop a new base case harvest forecast, follow the same steps: find the 
maximum LTHL, set the initial harvest level, and define the transitional harvest 
level. Keep in mind that the decisions you make in each of these steps may make 
it necessary to reconsider and adjust the previous steps. Target harvest levels are 
set in the targets.dat file. 

1 Find the maximum LTHL: The LTHL is the maximum harvest level that can be 
supported by an entirely second-growth forest. A simple and quick approach 
to finding LTHL is to use LRSY as a first estimate. Calculate LRSY using the 
AUs and volume tables you developed in the previous steps. Note that the 
areas shown in the GYParameters.txt file include only hectares that are older 
than 30 years. To find the areas needed for calculating LRSY, create a pivot 
table of the Inventory_Summary.txt file.  

2 Set the initial harvest level: Find an initial harvest level that is the maximum 
that can be cut without causing the harvest in later periods to drop much 
below the LTHL.  

3 Define the transitional harvest level: Find an acceptable transitional flow from 
initial harvest level to LTHL. There are many possible combinations of initial 
and transitional harvest levels, so you should decide early on what 
“acceptable” means. [Write it down.] For example, you might choose to 
maximize the first-decade harvest, subject to the following requirements: 

– the drop in harvest level between periods must not exceed some 
specified % 

– the target harvest level must be met in every period 

– growing stock inventory must not be declining at the end of the planning 
horizon 

– growing stock inventory must never be less than some absolute amount. 

 Your definition of an acceptable transitional flow defines the harvest flow 
policy for your analysis. Keep in mind that your choice of flow policy may 
require changing the initial harvest level.  

Run FSSIM and investigate the graphs and reports to evaluate each run. Adjust 
your harvest levels and repeat the process. Continue with this cycle of simulate-
evaluate-adjust targets until you feel that you have found an appropriate or 
acceptable base case harvest forecast. Record your runs and findings in the 
attached Table 4-1. 
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STEP 12 Use FSSIM to undertake sensitivity analysis to assess risk and uncertainty 
associated with the data 

Sensitivity analysis is done to determine the sensitivity of forest performance to 
changes in the value of the parameter and thereby determine the significance of 
uncertainty about the value of that parameter. The changes are always relative to 
the base case and, therefore, can only be done after the base case has been 
established.  

In general, sensitivity analysis involves first changing the value of a model 
parameter (e.g., minimum harvestable age), and then measuring the effect of that 
change on forest performance (e.g., maximum sustainable harvest). 

Making the change in the parameter being tested is straightforward—you simply 
change its value—but measuring the effect of that change can be more difficult. 

Measuring the effect on forest performance 

Measuring forest performance is difficult to do with timber supply simulation 
models because the quality of the outcome of a run is evaluated subjectively. 
FSSIM provides several indicators of the state of the forest in each period.  Many 
can be used as measures of forest performance: growing stock inventory, age 
class distribution in each period, mean harvest age, harvest-age distribution, 
mean volume per hectare harvested, and area harvested.  

Before beginning the sensitivity analysis, decide which criteria you will use to 
measure forest performance [Write these down].  

The following table indicates some examples of issues that can be tested with 
sensitivity analysis. You should do at least the first two on the list. Use Table 4-1 
to record your sensitivity analysis runs. Be sure to record the values you are 
testing in the assumptions column. Use Table 4-2 to record the issues you test 
and their sensitivities. 

Issue to be tested Sensitivity levels Data source 

Minimum harvestable age reduce minimum volume 
requirement or age 

Recent timber sale licences 
(experimental) 

Green-up height - 1 m  

Regenerated stand yields + 25% Class A seed 

Existing stand yields + 12% recent inventory audit 

Age when forest achieves “old” 
forest characteristics 

Reduce from 140 to 
100 years 

Radio-collar study in caribou 
and deer show use of 
stands with these attributes 

Site index estimate for older 
stands 

Adjust SI by equation 
provided by Research Branch 

Recent OGSI paired plot 
initiative 

Landbase changes   

Harvest flow alternatives rate of change between 
periods 

 

 
When adjusting the values of a parameter (for sensitivity analysis or when 
making a series of runs to determine the maximum long-term harvest level), 
change only one thing at a time. If you change the value of more than one 
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parameter before a run, you won’t be able to tell which of the parameters caused 
the change in model results. 

STEP 13 Suggest a silviculture strategy and recommend an allowable annual cut for 
the study area 

Based on your analysis, can you suggest an appropriate silviculture strategy for 
this management unit? Recommend an AAC for the next 5-year period.  

STEP 14 Produce and submit your analysis report  

Your report should describe the inventory, document the base case forecast and 
sensitivity analyses, and provide a rationale for the allowable annual cut 
recommendation. Attach your tables 4-1 timber supply analysis recording sheets 
and 4-2 issues and sensitivity analyses.  
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Table 4-1 Timber supply analysis recording sheet. 

Run # Assumptions  
(e.g., base, sensitivity to 
yield, treatment response, 
harvest rule) 

  Harvest target 
(000 m3/yr) 

  P1 growing 
stock  

 

Minimum growing 
stock 

 

Comments 

  P1 P2 P3 P4 P5 LTHL (million m3) (million m3) Period  
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Table 4-2 Issues and sensitivity analyses. 

Issue to be tested Sensitivity levels Findings  

   

   

   

   

   

   

 


